
Make a Proposed Sketch of Office 
 

4. Lay out the graph paper landscape. If you have the ability to tape the graph 
paper down on your surface using (recommended and preferred) painters’ tape. 
 

5. We are going to use the scale ¼” = 1’-0”. I’ll show the conversion between a 
regular ruler and an Architects’ Scale, during the live stream. 
 

6. During the presentation you will be drawing a 20’x32’ office building with a 
waiting area (20’x16’), an inner office (12’x16’), and two separate offices (8’x8’).  
 

7. Draw a box in the lower right hand corner for the Title Block (about 6 grid 
squares high by 16 grid squares long). 
 

8. Move up four grid squares from the Title Block and make a mark. This mark is 
the first corner of the building. With our measurement of 20’x32’, the drafter will 
draw a line (from right to left) that is 8” long representing 32’ in length.  
 

9. Next draw a line from the next corner upwards 5” long representing 20’ in length. 
 

10. Going from left to right draw another 8” line and then finish the exterior of the 
building. 
 

11. Next the drafter will mark the interior walls of the building. First measure out 16’ 
(in scale 4”) for the office divider from one of the vertical lines. From this mark 
draw a light line vertically splitting the office in half. 
 

12. Make a mark at 8’ (in scale 2”) from the bottom horizontal line. Create a 
horizontal line from the left vertical line to the middle vertical line. 
 

13. Make another mark measuring 8’ (in scale 2”) from the left vertical line. Create a 
vertical line from the bottom horizontal line to the middle horizontal line. 
 

14. Next the drafter will place the exterior doors, typical exterior doors are 36”. First 
measure 10’ (in scale 2-1/2”) and place a mark on the right vertical line.  
 

15. Place the ruler at 0” (zero) on the mark and slide the ruler to left until it reads 1.5’ 
(in scale 3/8”) is on the center mark. Place a very light mark there. Repeat this 
step for the right side of the center mark. 
 

16. Once the drafter has 3 very light marks place the ruler at 0” on the left mark. 
Move the ruler up till 3’ (in scale 3/4”) is on the mark. Draw a line from the vertical 
line to represent the first exterior door. 
 



17. Measure 8’ (in scale 2”) and place a mark on the bottom horizontal line. 
 

18. Place the ruler at 0” (zero) on the mark and slide the ruler to left until it reads 1.5’ 
(in scale 3/8”) is on the center mark. Place a very light mark there. Repeat this 
step for the right side of the center mark. 
 

19. Once the drafter has 3 very light marks place the ruler at 0” on the left mark. 
Move the ruler up till 3’ (in scale 3/4”) is on the mark. Draw a line from the vertical 
line to represent the second exterior door. 
 

Note: The difference between an interior door and an exterior door is that exterior 
doors have a threshold. Interior doors do not and therefore the line between the 
marks are removed (erased). A threshold shows a difference in ground material. 
 

20. Place the interior doors. The first interior door will be placed 2’ (in scale 1/2”) 
from the top horizontal line and place a light mark. 
 

21. Place the ruler at 0” (zero) on the mark and slide the ruler to left until it reads 1.5’ 
(in scale 3/8”) is on the center mark. Place a very light mark there. Repeat this 
step for the right side of the center mark. 
 

22. Once the drafter has 3 very light marks place the ruler at 0” on the left mark. 
Move the ruler up till 3’ (in scale 3/4”) is on the mark. Carefully Erase the two 
outer marks and the line leaving the center mark untouched. 
 

23. Repeat steps 21 and 22 for the next two interior doors along the middle 
horizontal line. One at 6’ (in scale 1-1/2”) from the left vertical line and one 4’ (in 
scale 1”) from the center of the last door. 
 

24. Dimensioning Rules: 
 

a. Dimensioning starts from the exterior measurements working inward. All 
exterior dimension vertical lines are 2’ (in scale 1/2”) from the exterior wall 
and all horizontal exterior dimension lines are 1’ (in scale 1/4”) from the 
exterior wall. 

 
b. All interior horizontal dimensions are centered in the room unless text is 

being placed. All vertical dimensions are placed 2’(in scale 1/2”) from the 
closest exterior wall. 

 
c. All door dimensions are placed 2’ (in scale 1/2”) from the closest interior 

wall ending with a vertical line pointing to the center of the door. 
 



d. All architectural ticks run 45 degrees diagonally from left (at the highest 
point) to right 1’ (in scale 1/4”). 

 
e. All dimension text will be centered on their line in Upper Case Gothic 

Lettering Format and will have inch annotation following the foot 
measurement (20’-0”). 

 
f. Vertical text will look the same from top to bottom as turned 90 degrees to 

the left. 
 

g. Horizontal text will be readable with the Title Block text. 
 

 
 

25. Title Block Annotation: 
 

a. Draw a horizontal line 2 grid squares down from the top line. 
 

b. Split the box into two sections vertically.  
 

c. On the right side draw a small horizontal line 1.5 grid squares down. 
 



d. In the top left box write, “PROJECT:” in the first set of grid squares and 
below that write “20’x32’ OFFICE”. 

 
e. In the top right box write, “DRAWN BY:” in the first set of grid squares and 

below that write your first and last name. 
 

f. In the second right box write, “SCALE: 1/4” = 1’-0”. 
 

g. In the bottom right box write, “DATE: 16AUG24”, or the day you finish the 
sketch. 

 

 

 

  



Support Bracket (SBRACKET) Specifications (Requirement 3b): 
 

1. New Drawing 
 

1. Select File from the home row tabs and in the drop-down menu select 
New From Template. 
 

 
 

2. First select the Stamp icon (Default Template Directory) and select the 
Imperial Folder. 
 

 
 

3. Select the middle template (A3 Landscape) and then select Create New 
Drawing. 
 

  



2. Layers: 
 

Layer 
Name 

Color 
Line 

Weight 
Line Type 

Plottable Snappable 

0 White Default Continuous No Yes 

CENTER Red 0.60 mm Center Yes Yes 

DIM Green 0.30 mm Continuous Yes Yes 

HIDDEN Yellow 0.60 mm Hidden Yes Yes 

OBJECT White 0.60mm Continuous Yes Yes 

TEXT Cyan 0.30 mm Continuous Yes Yes 

CLINE Any Default Continuous No Yes 

 
INSTRUCTIONS: 

 
 

1. Setup Dim Styles 
a. Select Edit in the drop-down menu select Drawing Preference 

 
b. Select Dimension Settings 
c. Edit Dim Styles 

1) Dimension Style check Horizontal Text Labels 
2) Dimension Style check Text above dimension line. 
3) Size 

i. Uncheck Keep Proportions 
ii. Text Height: 0.0945 
iii. Extension Line Extension (Extend Beyond Dim line): 0.0472 



iv. Extension Line Offset (Offset from Origin): 0.0472 
v. Dimension Line Gap: 0.023625 
vi. Arrow Size: 0.1417 
vii. Dimension Line increment (Baseline Dimension): 0.375 
viii. Size Scale Factor: 1 
ix. Arrow Style (for mechanical drawings only): Arrow 
x. Label Font: Arial 
xi. Label Color: By Layer 
xii. Linear Dimensions: Format: Decimal / Precision: 0.00 
xiii. Angular Dimensions: Format: Decimal Degrees / Precision: 0 
xiv. Select Apply 

4) Grid: uncheck all viewports 
5) Page: Paper Size: ANSI-D 

 
2. Draw Front View:   

 
a. Turn Off Grid 
b. Line:   

1) Type Line, then Enter.  
 

2) Type 0, 0 then press Enter.  
 

Notice that there is now a line connected to the curser. This is known as a 
rubber band and shows a preview of the line.  
 
Note: Snap Options 
 

 
 

3) Move the mouse to the Right and type 4.38, then Enter.  
 

4) Move the mouse Up and type 2.38, then Enter. 



 
5) Move the mouse to the Left and type 4.38, then Enter. 

 
6) Type C, then Enter to close the box. 

 
3. Offset Top and Right View: 

 
a. Offset:  

1) Select Modify in the drop-down menu select Offset (with distance) 

 
 

2) In the Tool Ribbon enter the following: 
i. Distance: 2, 
ii. Number: 1, 
iii. Polyline Mode: Offset Polyline 
iv. Join: Miter Join 
v. Clipping: Checked 
 

3) Hover over the Top Line of the Front View.  
 

4) Move the mouse Up to have a phantom line appear and left click.  
 
There should be a horizontal line 2.0 units above the front view. 

 
4) Hover the Right Line of the Front View.  

 
5) Move the Mouse Right and left click.  
 

There should be a vertical line 2.0 units to the right of the front view.  
 
 

4. Finish drawing the Top rectangle.   
 

a. Line:   
 

1) Type Line, then Enter.   
 

2) Select the Right side of the line.  
 

3) Move the mouse Up and type 2.12, then Enter. 
 

4) Move the mouse Left and type 4.38 Enter. 
 

5) Move the mouse Down and type 2.12, then Enter.  
 

6) Hit Escape on the keyboard to close the command. 



 

5. Finish drawing the Right rectangle. 
 

a. Line:   
 

1) Type Line, then Enter. 
 

2) Select the Bottom of the line.  
 

3) Move the mouse to the Right and type 2.12, then Enter. 
 

4) Move the mouse to the Up and type 2.38, then Enter. 
 

5) Move the mouse Left and type 2.12, then Enter, or select the end point at 
the top of the initial line.  
 

6) Hit Escape on the keyboard to close the command.  
 

6. Draw Miter Line 
 

The Miter Line is a line that divides the top and right side views at a 45° angle.  It 
is used to project lines to and from these views. 
 
a. Active Layer: 

 
1) On the right side of the screen select CLINE. 

 
There should be a pencil next to the layer CLINE identifying that CLINE is the 
current active layer. 

 
b. Line:   

 
1) Type Line, then Enter. 

 
2) Left click to the Top Right Corner of the Front View. 

 
3) Type @6<45, then Enter. 
4) Hit Escape on the keyboard to close the command.  

 
 
 
 
 
 
 



Note: Orthographic Projections should start with three views and a miter line, as shown 
in Figure below. 
 

 
 

7. Draw Details of the Front View 
 

a. Active Layer: 
 
1) On the right side of the screen select OBJECT. 

 
b. Offset Horizontal Line:  

 
1) Type OF, then Enter. 

 
2) Distance 0.38, then Enter.   

 
3) Hover over the Bottom line of the Front View. 

 
4) Move the mouse up, then left click.   
 

A new line should appear 0.38 above the bottom line.   
 

5) Hit Escape on the keyboard to close the command.  
 

c. Offset Horizontal Line: 
 

1) Hit Enter to re-open the Offset command. 
  

2) Distance 0.85, then Enter.  
 

3) Hover over the Bottom line, move the moues Up, then left click again.  

(TOP) 

(FRONT) (SIDE 
VIEW) 



 
d. Offset Vertical Line: 

 
1) Hit Enter to re-open the Offset Command.  

 
2) Distance 2.12, then Enter.  

 
3) Hover over the Left vertical line, move the mouse Right, then left click 

again.  
 

4) Hit Escape on the keyboard to close the command.  
 

5)  Hit Enter on the keyboard to re-open the offset command.  
 

6) Distance 0.38, then Enter.  
 

7) Hover over the Previous line that was offset.  
 

8) Move the mouse Right and left click.   
 

e. Draw Diagonal Line:   
 

1) Draw a line from the Top Right Vertical Line, to the Top Right Horizontal 
Line. 

 

 
 

f. Trim:  
 

Use the Dynamic Trim Mode to delete excess lines.  
 

1) Select Modify in the drop-down menu select Trim.  
 

2) Choose the Limiting Entity, this is object/line/etc. that the drafter wants to 
have a polyline stop at or have the End Point changed to start/stop at the 



limiting entity. Select the vertical line where the diagonal line is touching 
the top horizontal line. 

 
3) Next select the top horizontal line behind the Limiting Entity. You should 

see the top horizontal line Trim at the Limiting Entity and the excess line 
deleted. 

 
4) Hit Escape on the keyboard to close the command.  

 
5)  Hit Enter on the keyboard to re-open the trim command. 

 
6) Choose the Limiting Entity, select the horizontal line where the diagonal 

line is touching the second horizontal line from the top. 
 

7) Next select the far right vertical line below the Limiting Entity. You should 
see the right vertical line Trim at the Limiting Entity and the excess line 
deleted. 
 

8) Hit Escape on the keyboard to close the command.  
 

9) Continue using the Trim command until your Front View looks like the 
image below. 

 
g. Offset Horizontal Lines for Circle Location:   

 
1) Change Active Layer to CLINE. 

 
2) Type OF, then Distance 1.01.  

 
3) Hover over the Bottom Line, drag the mouse Up, then left click again.  

 
4) Hit Escape on the keyboard to close the command.  

 
5) Hit Enter on the keyboard to re-open the offset command.  

 



6) Distance 0.75, hover over the previous offset line. 
 

7) Move the mouse Up, then left click again.  
 

8) Hit Escape on the keyboard to close the command.  
 

h. Offset Vertical Line for Circle Location:  
 

1) Type Offset, then type 0.62.  
 

2) Hover over the Left Line, drag the mouse Right, then left click again. 
 

3) Hit Escape on the keyboard to close the command. 
 

 
 

i. Draw Circles:   
 

Place two circles at the intersections of the offset lines with a radius of 0.22. 
 
*Note: Ensure Intersection is enabled under OSNAPs 
 

1) Change Active Layer to OBJECT. 
 

2) Type CR (Circle at Center Radius), then Enter.  
 

3) In Radius type 0.22, then Enter. 
 

4) Left click on the intersection of the Bottom Horizontal Line, and the 
Vertical Line.  
 

5) Repeat step 4, but place a circle at the intersection of the Top Horizontal 
Line and the Vertical Line. 
 

6) Hit Escape on the keyboard to close the command. 
 

 



 
j. Connect the Circles:   

 
1) Draw lines between the Left Quadrants (References) and the Right 

Quadrants of the two circles.   
 

 
 

k. Delete and Trim Lines:   
 

1) Delete the horizontal and vertical lines used to find the location of the 
circles.  
 

2) Type D2 (Break out Segment), then Enter. 
 

3) Carefully select the inside portions of the circles to match the image below 
(should be four left clicks).  

 
 

8. Draw Details for the Top View:  
 

a. Offset: Offset the Top Line Down by 0.38. 
 

 
 
 
 



 
Use the Front View to project lines into the Top View.   

 
b. Projection Lines: Draw two lines from the Endpoints of the vertical lines from 

the Front View, perpendicular to the Horizontal Lines in the Top View  
 

 
 

c. Trim: Use Dynamic Trim Mode (RM) to delete line segments Between the 
Front and Top View.  

 

 
 
 

d. Change the Active Layer to CLINE. 
 

e. Create the Vertical Construction Lines; Location of the Right circle is 0.50 
from the Right Side and Left Circle is 0.88 from the Right Circle.  

 
f. Create the Horizontal Construction Line; Location of the circles is 1.26 Down 

from the Top Line. 
 

 



 
g. Change the Active Layer to OBJECT. 

 
h. Draw Circles: Diameter (ø) of the circles is 0.50 by typing CA (Center 

Diameter) in the command line. 
 

 
 

i. Draw Fillet:  
 

1) Type RN (Round), then Enter. 
A Fillet is curve connecting two surfaces. 

  
2) Drafting software need to know the radius of the fillet before the sides are 

selected, for this software the radius is inputted in the upper ribbon. 
 

3) Type 1.5, then Enter. 
 

4) Left click on the bottom line then the left line, by selecting just outside of the 
top view. 

 

 
 

9. Draw Details of the Side View:   
 
a. Change the Active Layer to CLINE. 

 
b. Projection Line 1: Draw a horizontal line from the Top View to the Miter Line 

creating an Intersection Point. 
 

c. Projection Line 2: Draw a vertical line from Miter Line down to the Side View.  
 
d. Projection Line 3: Draw a horizontal line from the Front View to the Side View. 



 

 
 

e. Change the Active Layer to OBJECT. 
 

f. Draw two lines to finish the image above using the Projection Lines previously 
created. 
 

g. Angle Line: Draw a line to make the angle in the upper left corner. 
 

h. Trim and Delete: Trim line segments between views.   
 

 
 

10. Draw Hidden Lines:   
 

Hidden lines show objects which are not visible in the view. Every surface and 
hole needs to be shown in all three views 

 
a. Change the Active Layer to HIDDEN. 
b. Projection Lines: Use the Hidden Layer and draw projecting lines from one 

view to another.  



 
 

 
 

c. Trim: Use the Trim Command to delete any excess lines within all three 
views.  

 
 

 
 

11. Draw Center Marks:   
 
Center marks identify the center and edges of arcs and circles. 

 
a. Change the Active Layer to CENTER.  

 
b. For this drafting software Center Line Marks are a Misc accessory under 

Draw called Center Cross (CS). 
 



c. Left click on Right circle in the Top View.  A center mark will appear. 
 

d. Select the Two Arcs in the Front View, and the Fillet in the Top View.  
 

 
 

e. Trim the Top and Right center mark lines within the Top View.  
 

f. Delete the top circle’s center vertical line and select the bottoms center 
vertical line. 
 

g. Strech the bottom circle’s center vertical line to the to top circle’s top 
quadrant.   

 

 
 

12. Draw Center Lines:   
 

A Center Line will represent the center of a thru-hole   
 

a. Projection Lines: Use the projection process to transfer all center lines to 
each view. 

 



 
 

b. Trim: Use the Trim Command to delete any excess lines within all three 
views.  

 
c. Stretch Center Lines:  

 
Center Lines should have a Long-Short-Long appearance and extend past 
the object line 1/8”.   

 
1) Left click on a center line.  

 
2) Grab the Endpoint grip.  

 
3) Move the mouse Up, type 0.125, then Enter. 

 
4) Repeat the stretch command on all Center Lines on both sides. 

 

 
 

d. Linetype Scale:   
 

Linetype Scale needs to be adjusted within properties to create a Long-Short-
Long appearance.  

 



1) Properties: Select the Center Line on the Top View and select the View 
tab and in the drop-down menu select Property Editor button, or type GP, 
then Enter. 
 

 
 

2) Scale: Change the Linetype Scale to 0.5. If the Center Line does not 
appear to be Long-Short-Long, type 0.2500 within the Linetype Scale. 

 

 
 

13. Offsets for Dimensions:   
 

a. Layer: Switch the Layer to CLINE 
 

b. Offset: Offset all sides that will have dimensions by 0.375.  
 

 



 
14.  Place Drawing Annotations 

 
a. Linear Dimension:  

 
The first dimension to be completed is always a linear dimension.   
 

1) Switch the Layer to DIM. 
 

2) In the main tabs select Dimension and in the drop-down menu select 
Aligned. 
 

3) Select the Lower Left corner of the Front View. 
 

4) Move the mouse Up and select the Left Endpoint of the next horizontal 
line. 
 

5) Move the mouse to the Left and click on the offset line.  
 

6) After the dimension has been placed, highlight the dimension. 
 

 
b. Baseline Dimension:  

 
A Baseline Dimension is a dimension that is positioned above another dimension 
line. 
 

1) Select the Baseline Dimension in the Dimension drop-down. 
 

2) The dimension will automatically populate within the drawing.  
  

3) Click on the Bottom Left Endpoint of the center mark.  
 



 
Figure 3.90 

 
c. Continuous Dimension:  

 
A Continuous Dimension is a dimension that continues off another dimension line. 
 

1) Select the Continuous Dimension in the Dimension drop-down. 
 

2) The dimension will automatically populate within the drawing.  
 

3) Click on the Top Left Endpoint of the center mark.  
 

 
 

Use the Linear, Continuous and Baseline dimensioning process to complete all three views. 
 

 



 
d. Leader Lines:  

 
A Leader Line contains a leader arrow, leader line (with landing) and a note.  
Note: Ensure Nearest is enabled within OSNAPs.  
 

1) Switch Layer to the Text. 
 

2) Select Text in the Draw drop-down. 
 

  
 

3) Change the height to 0.0945 and enter the 
desired text. 
 

4) Select the top end of the left vertical 
Construction Line used for dimensions.  
 

5) Select the newly created text and the select 
Move in the Modify drop-down.  
 

6) Using the Restriction (Ortho) Horizontal and 
Point Snap move the text to where the last 
entity of the text is just behind the 
Construction Line. 
 

7) Select Delete Original once the text is 
moved into place and select OK.  
 

 
 



8) In the Misc drop-down select Draw and in its right scrolled menu select 
Text Aligned Leader.  
 

9) In the first prompt (command line) for Arrow Position select the End of the 
top circle’s horizontal center mark line. 

 
10) In the second prompt for Choose Text select the newly created text. A 

leader line will be generated. 
 

                                                           
 

Use the Leader Dimensioning process to complete all three views. 
 

 
 

15. Preparing to Plot the Proposed Project 
 

a. Establishing Title Block information 
 
1) Enter Title Block section titles by selecting Text under the Draw drop-down 

 
2) Project – What is the project called? 



 
3) Drawn By – Who drafted the project? 

 
4) Scale – What is scale of the project? 

 
5) Date – The date the drafted project went in for revisions or finished plot. 

 
6) Sheet Size – The size of the sheet of paper the project is intended to be 

plotted on. 
 

7) DWG NO – Most firms have a drawing numbering system for projects and 
within the project some specialty items or features will have a specific 
number. 

 
8) Title – The title of the sheet if any. 
 

b. Fill in the Title Block with all critical information. 
 

 
 
 

  


